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rofile is a PC compatible software designed to be used with the Vericom VC3000 Performance Computer.
Profile is a user-friendly Windows program so even beginning computer users can utilize this powerful
tool. With Profile you can:
Organize and analyze data
Compare data
Save data to disk
Graph any combination of X and 8 Y axes
Display data in a table format
Make presentation quality Prints
Retrieve data from disk
Export data to be used in other applications
Compensate for Horsepower losses due to wind resistance, frictional drag and aerodynamic drag
Correct Horsepower and Torque to sea level standards
Calculate wind drag and frictional drag
Evaluate numerous formulas
Move a vertical line cursor along a graph to read instantaneous coordinates
Graph any segment of a curve
View the average of many runs
Display the results of many runs in one window
Save and reopen a table of runs
Play back the run with real time analog meters

2. Hardware Requirements
The computer must be 100% PC compatible and running Windows 95 or higher and have a USB port or an
unused RS232 serial communications port. The USB or RS232 port is for communicating with the VC3000. For
USB you must have Windows 2000 or higher. Any printer compatible with Windows will work with Profile.

3. Installing Profile
For Windows 95/98/NT/me/2000/XP:
1. Close all Windows applications.
2. Insert Profile Installation CD into your CD-ROM drive.
3. If setup doesn’t automatically start, then from the Start menu, choose Run.
a. In the Run dialog, type d:\setup.exe, where d is the letter of your CD-ROM drive.
b. Press Enter.
4. The installation program will guide you through the short installation process.
5. When the USB cable is plugged in and the VC3000 is turned on for the first time, Widows will detect new
hardware. See page 2 for USB serial port installation.
6. Once installation is complete select Start, Programs, Vericom Computers, Profile 3 to run the program.
We have included some example tests. To open the examples provided use File|Open… or press F4.
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NOTE:

Profile 3.x will not import data from the VC2000PC, but Profile 2.x runs can be opened.

Installing the USB serial Port
These USB drivers only work with Windows 2000/XP and higher. When the VC3000 is plugged into the USB port
for the first time Windows will detect new hardware. Follow this procedure for installation of the virtual serial port.
If you have the Profile installation CD, put it in the CD drive. If the Profile installation starts, click Cancel.
Turn on and connect the VC3000 to a spare USB port on your PC. This will launch the Windows Found New
Hardware Wizard. If there is no available Internet connection or Windows XP SP2 is configured to ask before
connecting to Windows Update, the screen below is shown. Select "No, not this time" from the options available
and then click "Next" to proceed with the installation.

Select "Install the software automatically (Recommended)" and click "Next".

Wait while Windows installs the drivers.
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Once the drivers are installed, the following window appears:

Select Finish.
This completes the first part of installation during which the USB to serial converter is installed. The second part
involves the installation of a serial port. This should follow automatically once the converter installation is
complete.
Follow the same procedure as above using the files from the CD.

Select "No, not this time" from the options available and then click "Next" to proceed with the installation.
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Select " Install the software automatically (Recommended)" and click "Next".
Wait while Windows installs the drivers.

Once the drivers are installed, the following window appears:

Select Finish.
This completes the installation.

Uninstall of USB drivers
• Unplug the VC3000 from the Computer.
• Open the control panel (Start, Control Panel) and click on "Add or Remove Programs".
• Scroll down the list and find the entry named "FTDI USB Serial Converter Drivers".
• Click the Change/Remove button.
• When the uninstaller opens, click the Continue button.
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When the uninstaller completes, click the finish button.

4. Quick Start Using Profile
When Profile starts you have the option of opening a run or importing new runs.

Importing
1. Turn the VC3000 on and connect it to the USB or serial port of your computer.
2. Select Import|Auto (or Auto Import Icon) in Profile to import the run headers from the VC3000 to Profile.
3. Now you have the option to open each run to a window, save the runs to disk, export the runs to an ASCII file
or delete the runs. When you import each run, this window appears:

4. If you choose the “To new run Window” option, remember to save the run to disk after uploading is complete
and header information is filled out.
See page 6 for details on uploading.

Opening a saved run
A file saved with Profile can be opened by Profile. It has the default extension .RUN but any extension will work.
Use File|Open, click the open icon or press F4 to open the Open dialog box. To change the file type filter to all
files select *.* from the file type drop down box, or select ASCII Files (*.csv) to open ASCII files saved from Profile
for DOS. Select a file by double clicking on it or select it then click on OK in the dialog box.
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Previously opened files can also be chosen from the File menu in Profile. A list of the most recent 5 opened files
is at the bottom of the File menu. Select a filename to open it.

Saving a run to disk
To save a run to disk after making a new run or modifying one select File|Save (Ctrl+S) or File|Save As.... If the
file is new or if Save As... is chosen a dialog box will open and you will need to type in a filename. The filename
can be any valid windows filename. Profile's default extension is .RUN but any extension can be used.

5. Importing Data
Automatic import uses the serial port or the USB port. When the VC3000 is plugged into the USB port and turned
on for the first time Windows will detect new hardware. See USB Serial Port Installation on page 2. Also, see
Profile help for details on confirming USB port installation. See COM port and baud rate in Options on page 42.
Turn on the VC3000 and plug it into the RS232 COM port or a USB port. If using the USB port, be sure the
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RS232 is not plugged in. Go to Import|Auto, or click on the icon, or press Ctrl+I. Profile will instantly import the
available headers into temporary memory.

Runway Friction Meter models will create a folder named "RFMRuns-the current date and time" as the folder
name and select it to save the data to. Click the Save All button to save the data to disk. The folder name
RFMRuns-011504-0917'39 for instance has the date in mm,dd,yy format and the time in hr,min,'sec format.
Select the To new run window button to import the data and put the run in a window. Then the data can be
viewed, graphed or saved.
When the Save As button is used for the individual runs, Profile will import the data then give you the opportunity
to name the run and select a folder to put it in.
Click the Delete button to take the run out of the Import window. This does not delete the run from the VC3000.
When one of the Save buttons in the Automatically Name box are used, Profile will automatically choose a file
name of "Runxxx.run", where xxx is the run number preceded by zero's, and continue using the Run Number from
the VC3000. Profile will put the files in the Default Data Folder shown in the Save To Disk box.
Use Save All to save all the runs in the Import window to disk.
Use Save Checked to only save those runs that you manually checked.
Use Save All ASCII to save the data to an ASCII file in .CSV format.
Use Save Checked ASCII to save only the checked runs to an ASCII file in .CSV format.
The default data folder may be changed by selecting a different folder from the window, or click the "Change or
Create Folder" button to open a folder on another drive or on a network, or to create another folder to put the data
into.
7

6. Exporting Data
Profile can export run data to ASCII text format, XML, HTML and directly to Microsoft Excel so other programs
can use the data Profile provides. There are three methods to export data:
1. When a run is open, use the File menu and select Save As ASCII... or Save As Text. A window will
open to give you a choice of the frequency and range to export the data.

Select the frequency and the range then click Ok. All available data from the VC3000 will be saved in the
ASCII or text file. For instance if only 1/10th of a second is enough frequency, then type 0.10 into the
"Output Every" box. It will only export the length of the run if the output range is greater than the run
length in seconds. Then accept the default file name and folder or type a new one and choose a folder.
The data will be saved as filename.CSV or filename.TXT. Use a spreadsheet or other program that reads
.CSV files to open the .CSV file. .CSV files are text files with commas separating the fields and can be
opened directly in Excel and other programs. The .TXT files can be opened by any text editor such as
notepad or Microsoft Word.
2. To export run data from a graph, first graph the run with all the data you want to export. Then click
Graph/Chart Editor or click the Chart Editor icon, then click the Export tab, then the Data tab. Now the
data or the picture may be exported to various formats. When exporting data, the graphics program will
export the X axis for every Y axis, so the data will have the order X Y1, X Y2, X Y3, etc.
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The data will look like the image below. Every other column will be the X axis repeated for every Y axis.
In the picture below is a brake test and Time is the X axis, Acceleration (G) is the first Y axis, Speed
(mph) is the second Y axis and Distance (ft) is the third Y axis. Select the extra X axis columns and
delete them.

3. To export run data from the Import window, after importing data from the VC3000 click on either the Save
Checked ASCII or Save All ASCII button. The same steps as saving from the file menu will be used, as
in method 1 above.

Use Save All ASCII to export all the runs to the Default Data Folder and automatically name them "Runxxx.csv",
where xxx is the run number preceded by zero's, and continue using the Run Number from the VC3000. Use
Save Checked ASCII to export in ASCII format only those runs that you manually checked.
To Export to ASCII and also save the runs to disk as Profile files, simply import the runs from the VC3000 again
and click the Save all or Save checked button.

7. VC3000 Setup
This window shows all the variables that can be changed in the VC3000. Use this setup in Profile to view and
change all the VC3000 settings in one convenient place. These settings only affect the VC3000 and will not
change the Profile settings.
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Buttons on the window:
• Get Setup: Gets the setup stored in the VC3000.
• Send Setup: Sends the new setup to the VC3000. No information is sent to the VC3000 until this button
is pushed.
• Set Clock: Sets the clock in the VC3000 to the time on your PC.
• Recall Factory: Set the variables to the factory default values.
• Save User: Saves the current setup to your computers hard drive for later recall.
• Recall User: Recalls the setup from the last time Save User was pushed.
Send Setup must be clicked to send the changes to the VC3000.

Units:
Metric or English units can be displayed by the VC3000.
Calculate Distance:
The VC3000 will calculate the braking distance for an exact speed if the actual speed is within 5 mph of the target
speed. 20 mph and 60 mph are common, but any speed can be used. The distance is calculated assuming the
vehicle was going exactly the target speed.
Pitch and Roll Factor:
See Pitch and Roll Factor on page 20.
G smoothing:
See G smoothing on page 20.
Trigger:
The VC3000 can be started by a countdown, by a G force threshold, by a sensor threshold or by an external
activation. Only one of the external sensors can be used to start a run. When a sensor is set to start the run, one
of three events may trigger the start of a run: the G-threshold, the external activation or the sensor voltage
threshold. If you don’t want the G-threshold to start the run, set it high, 0.500 G for example. Set the sensor
number to 0 to disable the external sensor threshold as a trigger. Check the DAB checkbox if the sensor you
want it to trigger on is on the DAB. If the sensor should trigger when the voltage is less than the trigger voltage,
check the "Less Than" checkbox. Check the Countdown mode to activate the run after a countdown sequence.
User Type:
Changing the user type changes the data that is displayed after a test and when runs are selected from memory.
In some cases it will change how the test starts and will change other user settings.
Accident Reconstruction:
Display – Brake mode:
• Reaction Time
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Reaction Time distance
Elapsed Time
Speed
Distance
Avg. Gx
Avg. Gy
Peak Gx and the time it occurred
Peak ± Gy
G every 0.10 sec.

Display – Acceleration mode:
• Time to programmed parameter
• Speed to programmed parameter
• Distance to programmed parameter
• Avg. Gx
Transit:
Display – Brake mode:
• Reaction Time
• Reaction Time distance
• Elapsed Time
• Speed
• Distance
• Adjusted Distance to predetermined speed
• Avg. Gx
• Avg. Gy
• Peak Gx and the time it occurred
st
• 1 Peak Gx and the time it occurred under 0.75 seconds
Display – Acceleration mode:
• Time to programmed parameter
• Speed to programmed parameter
• Distance to programmed parameter
• Avg. Gx
OT - Rehab:
• Does not zero the accelerometer before a run
Display – Brake mode:
• Reaction Time
• Reaction Time distance
• Elapsed Time
• Speed
• Distance
Display – Acceleration mode:
• Time to programmed parameter
• Speed to programmed parameter
• Distance to programmed parameter
• Avg. Gx
Advanced:
Display – Brake mode:
• Reaction Time
• Reaction Time distance
• Elapsed Time
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Speed
Distance
Adjusted Distance to predetermined speed
Avg. Gx
Avg. Gy
Peak Gx and the time it occurred
st
1 Peak Gx and the time it occurred under 0.75 seconds
Peak ± Gy
G every 0.10 sec

Display – Acceleration mode:
• Time to programmed parameter
• Speed to programmed parameter
• Distance to programmed parameter
• Waypoints
• Avg. Gx
• Avg. Gy
• Peak Gx at time, speed, dist
• Peak Gy at time, speed, dist
• Peak HP at time, speed, dist, torque, RPM
Vehicle I.D.:
A 6 digit number identifying the vehicle. The I.D. will print on the thermal printer and will also display in the
vehicle field when imported to Profile.
Click on the next General tab (“General…”) to see the less commonly changed VC3000 settings.

Zeroing On:
Turn zeroing for the accelerometers on or off. When zeroing is turned off the VC3000 assumes a perfectly level
surface. The accelerometers are normally zeroed for incline and temperature changes, but in some cases that
may not be desirable. For example if you cannot come to a complete stop to push buttons before the test.
Graph Range:
The X and Y axis range of the graphs on the VC3000 can be changed to anything from 0.1 to 2.0. This range
only affects the maximum range of the bar graphs and friction circle in continuous mode.
Vehicle Weight:
The curb weight of the vehicle. Vehicle weight is used in horsepower and torque calculations only.
Roll-out Distance:
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The distance the vehicle must travel before the timer, speed and distance start in the VC3000. At a dragstrip for
instance the roll-out is generally about 12 inches if you shallow stage. By using the roll-out distance, the VC3000
time and the dragstrip time will match more closely. The VC3000 actually logs all the data, even before the rollout distance so it can send that information to Profile, but the VC3000 recalculates the time from the roll-out
distance. Profile has its own roll-out distance calculation in Quick-Stats.
Tachometer:
Turn each of the tachometers on by checking the ON checkbox. Tachometer 1 is used for engine RPM and is the
tachometer used in torque and gear ratio calculations. Set the Tach Factor from 1 to 99. The Tach Factor
represents the number of signals the tachometer gets in 2 revolutions of the engine. If no tachometer is used but
the OBDII is connected to the VC3000DAQ and the tachometer is turned on, Profile will use that tachometer
information to calculate torque and gear ratio.
Tachometer 2 may be used for drive shaft or wheel RPM.
Alarm Threshold:
If the alarm thresholds are turned on, the VC3000 will beep when that threshold is reached. Any number greater
than 0.000 will turn the alarm on, and 0.000 turns the alarms off.
Battery %:
Indicates the battery percent remaining when the "Get Setup" button is clicked.
Baud Rate:
Indicates the baud rate that the VC3000 is set to.
Click on the Sensors tab to change or view the VC3000DAQ sensor setup.

Sensors 1 - 6 are the analog sensors that are connected to the VC3000 or the junction box. The DAB Sensors 1 16 are the sensors that are connected to the DAB box. Click the ON check box next to the sensor you want to
turn on. Click the Calibrate check box if you want to zero the reading when the VC3000 zero adjusts its
accelerometers. Zero adjusting sensors should only be used for accelerometers, rate gyros or similar
sensors. Other sensors that the units range is balanced above and below zero may also use zeroing, so long as
the values are supposed to be zero when the VC3000 zero’s them. Sensors that have a units range from 0 to a
positive number should not be zero adjusted.
Sensor Trigger:
The VC3000 can be started by a countdown, by a G force threshold, by a sensor threshold or by an external
activation. Only one of the external sensors can be used to start a run. When a sensor is set to start the run, one
of three events may trigger the start of a run: the G-threshold, the external activation or the sensor voltage
threshold. If you don’t want the G-threshold to start the run, set it high, 0.500 G for example. Set the sensor
number to 0 to disable the external sensor threshold as a trigger. Check the DAB checkbox if the sensor you
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want it to trigger on is on the DAB. If the sensor should trigger when the voltage is less than the trigger voltage,
check the "Less Than" checkbox.
Click on the OBDII tab to change or view the VC3000DAQ OBDII setup. The OBDII sensors to monitor from the
VC3000DAQ can be turned on here.

OBDII Delay Time:
Sets the number of milliseconds that the VC3000 will delay before sending the next request for OBDII data.
Normally this delay is set to 10 milliseconds but some vehicles require a longer delay to function correctly. If the
OBDII timeout count (Continuous OBD Mode) increments, either a non-supported OBDII parameter is being
monitored or this delay needs to be increased.
CLEAR all to OFF:
Sets all OBDII monitoring OFF.
Scan Rate:
Sets the rate of how often the OBDII sensors are read. The more sensors that are turned on, the slower the
update rate of all the OBDII sensors. The is due to the vehicles slow update rate of the OBDII interface. So if you
are monitoring slowly changing sensors, such as temperature, use Mid or Slow scan rate so the quickly changing
sensors are scanned more often.
•
•
•
•

OFF Turns OBDII monitoring OFF for the selected parameter.
HIGH Turns OBDII monitoring ON with scanning set at the highest rate for the selected parameter. Use
for fast changing parameters like RPM and vehicle speed.
MID Turns OBDII monitoring ON with scanning set at middle rate for the selected parameter. This rate
scans at the HIGH rate divided by 32.
SLOW Turns OBDII monitoring ON with scanning set at slowest rate for the selected parameter. This
rate scans at the HIGH rate divided by 128. Use this setting for slow changing parameters like
temperature.

When an RFM model is connected to Profile the tabs will change to reveal only the information associated with
the Runway Friction Meter. Click on the Runway Friction tab to change the RFM only settings.
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You can type in the Airport name and operator info here then send the setup to the VC3000.
Airport Name:
The name of the airport. This will appear in the report.
Operator Name:
The names of the persons performing the tests. Up to 6 users and ID’s can be stored in the VC3000.
Operator ID:
If the operator has an ID number, type it here. Otherwise leave it blank.
Run Time:
The time the VC3000 will record data for in a braking test. For instance, if the Run Time is set to 1.0 second the
VC3000 will start when the G threshold is broken and stop after sampling for 1 second, which is 100 samples.
When the Run Time is set to anything other than 0, the VC3000 assumes you will not be coming to a complete
stop and will not calculate speed or distance. Profile will calculate speed and distance when viewing the
individual run, but they will not be accurate because you did not come to a complete stop.
RFM Mode:
Normally electronic decelerometers use average acceleration for the friction number of runways and taxiways but
the VC3000 has a setting where it will use the peak acceleration to be compatible with old mechanical devices.
Note that on ice peak may be two or more times higher than average.
RFM Sensors 1 and 2:
To setup a different temperature sensor, use Tools/Options and set sensors 1 and 2 to the correct ranges, then
click on VC3000 Setup again and send the new settings to the VC3000. Factory default values are: Sensor 1 is
1V to 5V and units range of -40 to 140. Sensor 2 is 0V to 5V and units range of -40 to 200.
Send Setup must be clicked to send the changes to the VC3000.

8. Header Information
The information such as vehicle name, location, date, etc. is called the header for the run. By changing some of
the variables such as weight or flatplate area, Horsepower and Torque calculations are affected. Select
View|Header from the menu or click on the Header tab at the top of the run page and all run header variables for
the run will be displayed. Following is a description of each header variable.
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Vehicle and Location:
Up to 30 characters each.
Date and Time:
The VC3000 will send the date and time that the test was performed.
Run Number:
The run number will be uploaded automatically from the VC3000.
Run Length:
Length of the run in seconds. This field cannot be modified. In brake runs you may notice that when uploading
the run the time is about 0.20 seconds greater than the run length of the VC3000. It will be readjusted after the
run is uploaded. See page 25 for more information on brake run time.
Weight:
The weight is for Horsepower and Torque calculations only. It should include vehicle and passenger weight.
Weight is uploaded from the VC3000 when the run is transferred to Profile. It can be changed in at any time and
Profile will recalculate HP and Torque.
Drag:
Drag is the frictional drag including bearings, U-joints, tires, etc. The higher the drag you type in, the more Profile
will increase the Horsepower to compensate.
FlatPlate:
FlatPlate area is the aerodynamic drag area of the vehicle including the windshield slope, body curves and wind
drag under the vehicle. FlatPlate area only affects the horsepower and torque over about 60 mph where wind
drag becomes large. The larger the flatplate area the more profile will increase horsepower and torque. With a
flatplate area of 0, altitude and wind have no affect on the horsepower and torque calculations.
As long as Altitude, Temperature, Wind, Humidity, Barometric pressure, Drag and FlatPlate are consistent, they
do not need to be accurate to get comparison data. If engine modifications are made to the vehicle the changes
will still display if they are dramatic enough to affect the vehicle.
Wind:
Use + for a headwind and - for a tailwind. Wind only affects HP and torque numbers if flatplate is greater than 0.
Temperature:
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Flatplate area compensation and adjusting to sea level use temperature in the calculations. Generally the warmer
it is the less HP the engine will make. The default and standard temperature is 60°F.
Humidity:
Relative Humidity is the ratio of the amount of water vapor in the air at a specific temperature compared to the
maximum amount that the air could hold at that temperature, expressed as a percentage. In a high humidity
environment an engine can't get as much oxygen as it would in a low humidity environment therefore decreasing
Horsepower.
For Profile to accurately calculate the sea level standard HP and Torque it needs to know the correct Relative
Humidity on the day of testing. The humidity variable affects Horsepower at sea level (HP SL) and Torque only.
The higher the humidity when testing, the more Profile will increase the Horsepower to compensate back to 0 %.
Type a number representing the percentage humidity into the humidity variable location in the header for the
current run. You can find the correct humidity with a store bought meter, from a weather site on the Internet or
from the national weather service.
% HP loss:
Horsepower losses are due to the power it takes to accelerate the inertia of the rotating masses (crankshaft,
flywheel, transmission gears, tires, etc.) and due to frictional losses. Some of the frictional losses are accounted
for using Drag but since power is not applied when this measurement is taken the extra friction under a load is not
measured.
After all variables are entered you should have HP values for a standard day at sea level, and after the % HP
Loss variable is entered you should have HP values that represent what an engine dyno would give. Generally %
HP loss will be 15% to 25%. An optimist would say 25% and a pessimist would say 15%. It varies depending on
transmission type and the amount of friction in the system.
The best representation of maximum HP is in top gear because gear reduction loss in the higher gears is less.
% HP Loss affects Horsepower, Corrected Horsepower and Torque calculations only.
Smooth HP (Smooth Factor):
The Smooth Factor is used in Horsepower and Torque calculations only. It is for making the graph appear more
uniform. Small changes in G force become amplified when multiplied to get HP. This makes the graph look
erratic. A smooth factor of 10 or 20 usually looks the best. The smooth factor averages the horsepower and
torque by the number used. A smooth factor of 50 uses 50 samples before and 50 samples after the current
sample and divides by 101 to get the average value for the current sample.
Barometric Pressure:
Barometric pressure is atmospheric pressure, the force exerted on a surface by the weight of the atmosphere,
corrected to sea level. Standard barometric pressure at sea level is 29.921 inches of mercury (Hg). The more
pressure available the easier an engine can pull the air in. The variable barometric pressure in Profile is used
only to calculate Station Pressure. Barometric pressure is the value given by weather stations or most other
sources of weather. It includes Station Pressure and correction for altitude and is referred to as corrected
pressure. Profile uses Station Pressure for its calculations, not Barometric Pressure.
Station Pressure:
Station Pressure is the Absolute Pressure. Absolute pressure is the pressure at the altitude you are at. Using
barometric pressure and altitude Profile can calculate Station pressure. Most gauges and the weather stations
give barometric pressure. Station pressure is used in Profile to correct HP and Torque to sea level values.
Altitude:
The Altitude header variable is used in compensating HP and Torque for wind resistance, and for calculating
Station Pressure if Barometric Pressure is known. It's also used for calculating flatplate area. If flatplate area is 0
then Altitude has no effect on uncorrected HP. At higher altitudes pressure is less therefore less air molecules to
affect the flatplate of the vehicle. This number should be actual Altitude from sea level, not adjusted altitude.
Profile calculates adjusted altitude internally to compensate for barometric pressure, humidity and temperature
effects.
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Braking runs and header information:
Brake runs will not show the Smooth Factor, Altitude, Temperature, Wind, Humidity, Barometric pressure, Station
Pressure, Drag or FlatPlate for a Brake test because only horsepower and torque are affected by these variables.

9. Viewing Data
Select View|Data from the menu or click on the Data tab at the top of the run window and all data available for the
run will be displayed. Brake runs will have only Time, G, Speed and Distance. In an acceleration run Time, G,
Speed, Distance, HP and HP at Sea Level are shown. If the tachometer was used for acceleration runs then
RPM, Torque and Gear ratio will also be shown. If extra sensors were used the sensors with the names and units
you gave them will also be shown. Sensors can be turned on and off in View|Sensor Setup... or by clicking on
the Sensor Setup tab at the top of the run window. The Sensor Setup tab only appears if sensors were used in
the test.

Printing the data
The entire table of values of the current open run can be printed. First open a file. Next select File|Print…. A
dialog box will open allowing you to choose the print frequency and the range. It will default to the run length and
every 1/100 sec.

When you click OK the Print dialog box opens. Click OK to send the data to the printer.
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10. VC3000 Settings
The settings show how the VC3000 was setup for each run. This tab is mostly for reference, but some values
may be changed. Suspension Settle time, Pitch and Roll Factor and Smoothing factors may be changed to finely
adjust the data.
The original values are not editable. They are the values the VC3000 had when the run was performed. The
Trigger box shows how the VC3000 started, with a G Force threshold, external switch, countdown mode or one of
the sensors. If a sensor started the run, it will display the sensor number and the voltage that triggered it. If the
sensor was set to trigger when the voltage was less than the threshold voltage, then the "Less Than" check box
would be checked. If it was set trigger when the voltage was greater than the threshold, then the check box
would not be checked.
The sensors that were turned on will have a check mark. If it was set to calibrate the sensor, that check box will
be checked.
Brake runs only show the necessary information for brake runs, no weight, rollout distance or tachometer.

Suspension Settle time:
Suspension Settle time is calculated in the VC3000. It is the time it takes for the suspension to unload after the
vehicle stops. It looks for changes in the curve and intelligently calculates where the vehicle actually stopped.
Sometimes it is impossible to calculate the suspension settle time and therefore the VC3000 will use a default of
0.20 seconds. Also sometimes it will miscalculate the settle time because of an abnormal curve. Change the Gx
smoothing for the run to 2 and look at the graph to determine if the settle time is close if you question it. If it looks
wrong, click on the VC3000 Settings tab for the run and change it to where you think it should be. Look for where
the curve changes to a steep angle.
Average G is affected very little or not at all, speed is affected a little and distance is affected the most by changes
in suspension settle time.

Acceleration and continuous runs show only the necessary information for acceleration runs, no settle time.
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Pitch and Roll Factor:
The Pitch and Roll factors are numbers that Profile multiplies with G. By typing in 1.03 Profile will multiply every
G value 1.03. By changing the Pitch factor; G, distance, speed, horsepower and torque are affected. By
changing the Roll factor only Lateral G is affected. Generally the Pitch factor and Roll factor should be 0.970.
The VC3000 Pitch factor and Roll factor are passed to Profile so the data will match.
The only time the Pitch factor should be adjusted in Profile is if you did not adjust the Pitch factor in the VC3000.
The only time to adjust the Pitch factor in the VC3000 is if vehicle is an experimental or non highway vehicle such
as rail cars or boats or for low friction surfaces like ice when the average G is less than 0.250 G. For example
when brake testing on ice the Pitch factor in the VC3000 should be set to 0, not the default 1. This is because the
suspension tilt is nominal. This will affect all the calculations made by Profile.
G smoothing:
Smoothing is used to eliminate some of the vibration associated with vehicle testing. Smooth factors from 0 to 9
may be entered. The smooth factors affect the VC3000 calculations very little. The G data sent to Profile is the
raw data before smoothing and Profile uses the VC3000’s smooth factor by default, but can be changed for more
or less smoothing effect.
The thick line is a smooth factor of 3 and the jagged line has no smoothing.
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11. Sensor Setup
Select View|Sensor Setup... or click on the Sensor Setup tab at the top of the run window to change the sensor
names, units, ranges or activation of each sensor. Up to 6 sensors can be added directly to the VC3000DAQ
through a junction box and up to 16 more sensors can be added to the optional Data Acquisition Box (DAB) for a
total of 22 additional analog sensors. The Data Acquisition Box is an analog to digital converter box that includes
12-bit Analog to Digital converters, regulated 12V and 5V outputs and its own battery pack. Sensors must be in
the range of 0 to 5V.
This sensor setup window lets you activate or deactivate each sensor, give each sensor a unique name and units,
and set the scaling for each sensor. Scaling is set using the Units Range High and Low, and the Input Volts High
and Low. If you bought a sensor from Vericom, it may be in the predefined Sensor List

.

The Low or High range can be any number between -99999.999 and +99999.999.
Active sensors are set automatically when importing a run from the VC3000DAQ. Once the file is transferred to
Profile, any sensor can be activated or deactivated by clicking on its Active check box. The first 6 sensors are the
ones that were connected to the VC3000DAQ or junction box. The rest of the sensors are the ones that were
connected to the DAB. Sensors that were on during the run will still appear in graph, display average and the rest
of Profile regardless of the checkbox status.
The Sensor Setup tab will only appear if one or more external sensors in the VC3000DAQ were turned on. Select
View|Sensors from the menu or click on the Sensor Setup tab at the top of the run page to set the values for
Name, Units and Range. Use Options to set the default sensors for all imported runs.

To choose a pre-defined sensor, click on the Sensor List button next to the sensor. The following dialog appears.
Click the down arrow to choose from the list of pre-defined sensors.

You may also edit the Range low, high and the Voltage low and high fields directly by typing numbers into them.
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You can add your own sensors to the list by modifying the Profile.ini file in the Windows folder. Double click on
the Profile.ini file then find the section titled [PresetSensors]. Go to the bottom of the list and add the 6 fields
necessary for each sensor. Use the same number after the field name for the same sensor. It is best to start
your custom sensors with 99 and decrement so they do not interfere with any future factory preset sensors. See
the example below.
example:
[PresetSensors]
.
.
.
Name13=Switch
Units13=on/off
Base13=0
High13=5
InputLow13=0
InputHigh13=5 new ones after this:
Name99=custom1
Units99=Units1
Base99=0
High99=5
InputLow99=0
InputHigh99=5
Name98=custom2
Units98=Units2
Base98=0
High98=5
InputLow98=0
InputHigh98=5
After editing the Profile.ini file, save the changes to disk.

12. View OBDII sensor setup
Select View|OBDII Sensor Setup from the menu or click on the OBDII tab at the top of the run page and the
OBDII sensors and their settings will be displayed.

If the sensor was turned on for the run it will have a check mark next to it. Sensors that were not turned on are
grayed out and unchecked. To hide an OBDII sensor column in the data window, uncheck the sensor. Sensors
that were on during the run will still appear in graph, display average and the rest of Profile regardless of the
22

checkbox status.
Smooth number: Since OBD has a relatively slow update rate, it usually looks like a staircase pattern. To
compensate for this, each OBDII parameter can be smoothed by typing a number into the Smooth box next to
each sensor. Numbers from 0 to 99 are allowed.
OBDII Speed Calibration is for converting the OBDII reported speed to actual speed.
Calibration methods on page 44.

See OBDII Speed

OBDII Adjusted Speed is calculated by smoothing the data from the OBDII vehicle speed and by multiplying by
the Speed Calibration Ratio calculated in the box next to Vehicle Speed.
Calculate OBDII Distance is calculated from the OBDII Adjusted Speed. Changes to the OBDII Speed
Calibration will also affect the OBDII distance calculations since it uses the adjusted speed data to calculate the
OBDII distance.

13. Runway Friction Meter Steps
Typical steps to import and view a report from a VC3000RFM.
1.
2.
3.
4.
5.
6.
7.

Perform tests on runway.
Connect VC3000RFM to Profile (through wireless link, RS232 or USB cable.)
Click the Import button (or menu item Import|Auto).
Click on the “Save All” button. Click the “OK” button when it finishes importing the data.
Click on the Runway Friction Report button (or menu item Tools|RFM Report).
An open dialog box displays showing the imported runs. Click the Open button to select this folder.
See page 24 for report details.

14. View Each Runs Information
To open an individual run, close the Runway friction report window if it is open, and then click the Open button (or
File|Open…). Find the run you want and double click it or select it then click Open.
When a VC3000RFM is used with Profile, another tab with the airport information appears for each runs data.
This is information that was downloaded with the VC3000 data. Only the Airport Name, Operator Name and
Operator ID can be changed.
Airport Name:
The name of the airport the testing was conducted at.
Operator Name:
The name of the person who performed the test.
Operator ID:
The ID number if any of the operator.
Runway:
The runway or taxiway designator.
Runway Zone:
The zone tested in this run. It will be Touchdown, Midpoint or Rollout.
Friction Number:
The friction value for the segment of runway tested in this run. It is the average acceleration rounded to the
nearest 1/100th G then multiplied by 100 to get a whole number. 23 is actually -0.230 average acceleration.
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15. Runway Friction Meter Report
To display a report you must first import the data to a folder. See Importing data on page 6. Then select
Tools|RFM Report or click the RFM Report icon. Then select the folder with the runs you want and click the
Open button on the lower right.
The Runway Report tab shows the summary of the tests.

The Detail Run Information tab shows the data from each test. To delete a run from the summary tab, click the
Deleted check box next to the run you want to delete. It can be added back in at any time by unchecking the
Deleted check box. FN is the Friction Number for the individual test. Individual tests can be opened by closing
the report window then clicking on the Open icon. Find the folder with the runs in it and double click on a .run file.
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To print a report click on the printer button. Now you can preview it and print it, or print immediately, or save to
disk in several different formats.

From the preview screen you can also print it or save it in several different formats.

16. Brake Test Calculations
In a braking test the G values for the suspension settle time at the end of the run, usually 2 tenths of a second,
are not used in any calculations because these values are a result of the suspension settlement. In fifteen years
of testing we have found the suspension settle time to vary 0.10 to 0.23 seconds. Varying the settle time by +0.13 sec. makes very little or no difference in the average G calculations. It will have the most effect on the
distance calculation. You will notice the complete test including the suspension settle time is included in the
graph but the calculations do not include the suspension settle time G values.
To change the suspension settle time use the VC3000 Settings tab for the run. The settle time shows 2 values.
"New" is editable and changes where the end of the test is, and "Original" will show what the VC3000 calculated
for the settle time.
When comparing the VC3000 to other methods of speed, distance or drag factor calculations be sure you
understand how the VC3000 works. For instance: When comparing a bumper chalk gun distance to the
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VC3000 distance the two have to trigger at the same time. This means using the external activation switch of
the VC3000 and connecting it to the same source that activates the bumper chalk gun. The bumper chalk guns
distance must also be compensated for its mechanical reaction time, usually 0.04 seconds, since the VC3000
activates instantly and it takes some time from the when the power to the chalk gun starts to when the chalk
actually hits the pavement. When using the VC3000 external activation switch mechanical reaction time is now
included in the VC3000 calculations and drag factor is not correct for the road surface. To compensate for this
use Calc Average to eliminate the mechanical reaction time. Find the time from the graph or data where the
VC3000 first reaches 0.200 G. Use that as the start time and use Profile's default end time (DO NOT include the
suspension settlement).
To measure true drag factor it is recommended that the VC3000 be activated by its default 0.200G threshold.
When comparing speed it will not make a significant difference whether the VC3000 is started using the brake
lights or the 0.200 G threshold.
Notice that when distance is used to calculate average G, error in average G can occur. This is due to the fact
that the calculation assumes constant G and in a typical skid, G is not constant. Summing the G samples and
dividing by the number of samples is the true scientific way to get average G and Drag Factor. Using the speed
divided by time method is the same as summing the G samples and dividing by the number of samples since
speed is the summation of G values and is the area under the Time-G curve.
Braking runs and header information:
Braking runs only show the necessary header information. There is no need to change the default values for
Weight, Smooth Factor, Altitude, Temperature, Wind, Humidity, Barometric pressure, Station Pressure, Drag,
FlatPlate or % HP loss for a Brake test. Only horsepower and torque are affected by these variables.

17. Quick Stats for acceleration runs
Quick stats is used for retrieving statistical data from the run similar to the displayed statistics from the VC3000.
Open an acceleration run then click the icon for Quick Stats
or choose Tools|Quick Stats from the menu.
Time at the distance points is interpolated to the nearest 1/1000th of a second. Average HP SL and Average
Torque are calculated up to the time, speed or distance point. In the case of a range such as 35MPH to 70MPH
the Average is within the range. The range 35MPH to 70MPH is an example of a range to select when looking for
the peak Horsepower in one gear. You will need to add a different range for your car if it shifts at different points.
Without flat plate area and the other header variables generally you want to pick a gear that that max.'s out under
70 MPH because after that wind resistance decreases Horsepower. If you have your cars flat plate area typed
into the header usually you will get peak HP in high gear. HP in lower gears is reduced by the amount of power it
takes to increase the speed of the mass of the lower gear ratios.
"---at Pk HP" and "---at Pk Torq" refers to the statistics within the range above it.
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When the window appears for the first time it displays the default statistics and no Rollout Time. Select the
Options tab at the bottom of the window or select View|Options to make new statistics and to set the Rollout
distance. Then click on the "Show Rollout Calculations" check box to subtract the Rollout time from the time to
distance points.
Comments can be included for printing in the last column for each row.
To make a new statistic first select Distance, Time or Speed interval. Then type in the Start and the End statistic.
To set the Rollout distance select Inches or Centimeters then type in a number. Generally the Rollout will be
between 10 and 18 inches. Now click the Quick Stats tab or select View|Quick Stats to see the results. The
options are saved to disk when exiting Quick Stats so the next time you use Quick Stats it will have the Options
and Rollout distance you used last.

To delete any of the new calculations, click on the calculation on the Quick Stats tab sheet and push Delete on
the keyboard.
To delete all the new calculations and set the Options back to defaults, click on Edit | Default list.
End Stats are a quick summary of the end of run data.
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18. Quick Stats for braking runs
Quick stats is used for retrieving statistical data from the run similar to the displayed statistics from the VC3000.
or choose Tools|Quick Stats from the menu. An
Open a braking run then click the icon for Quick Stats
adjusted distance can be calculated if the target speed is within 5 MPH of the actual speed. This is because it is
impossible to calculate an accurate distance if the speed difference is greater than 5 MPH. If the test is close to
20 MPH click the 20 MPH button to calculate what the distance would have been if the vehicle would have been
going exactly 20 MPH. Similarly for 60 MPH. Any other speed within 5 MPH of the actual speed can be used by
typing it into the box then hitting Enter or clicking the Calculate button.
Reaction time is the time from when the VC3000 was externally activated, from the brake lights or the reaction
timer switch, to when the vehicle reached the G force threshold, normally 0.200 G.

19. Calculate Averages for a run
Using Calc Averages you can select any part of the run and get an average. To get the average G between any
two points type in any time in the Start and End Time boxes. The End Time must be greater than the Start Time.
The currently active run will be used for the calculations.
For brake runs the End Time will default to the run length but can be changed to include the last 0.20 sec. See
page 25 for more details on the run length of brake runs.
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20. Formulas Window
A variety of formulas are expressed in Profile. These formulas can be used by performance enthusiasts as well
as accident reconstructionists. Select Tools|Formulas then type a number into the variable locations. Numbers
in the red boxes change when any value is changed. The new result will be displayed. Some numbers are
calculations only and cannot be modified.
Click the Print button to print the current tab sheet to a printer.
Click on the tabs at the top of the Formulas dialog box to view more formulas. The values will be updated when
you hit enter, tab or click on the Calculate button.

There are several formulas that have a summation button by it. These formulas can be expanded in another
window and one of the variables can have a range of values so the formula will calculate a table of values for the
result.

Any formula that has the Math button can be expanded.
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Formula Window
The Results box is what is being solved for. In the example above, it is "S" in MPH and ft/sec.
The Inputs box is for the variables in the equation. In the example above they are Distance, Drag Factor and
Brake percentage.
The Table Inputs box is for creating a table by varying one of the variables from the Inputs box. First select the
input to vary from the Variable box, then type in the starting value in the From field, the number of rows or number
of calculations in the Table Size field and the value to increment the chosen variable in the Step Value field. Now
click on the summation icon (Σ) to create the table.
In the example above the Distance was set to 100 ft and the drag factor was varied starting at 0.700 G and
increased every 0.010 G with 21 values in the table.
Click the summation icon (Σ) to make or update the table. Click the print preview button to see what will be
printed. Click the print button to print to the selected printer.

21. Display Average of many Runs
The Time, G-Force, Speed, Distance, HP, HP at sea level, RPM, Torque, Gear ratio, attached sensors and other
run parameters can be displayed and averaged for many runs. Any or all of the information can be added or
removed by clicking next to the information in the check box. On brake tests, only Time, G, Speed, Distance and
active sensors are available. Files must be saved to disk to use in Display Average.
Use Tools|Display Average. When the Open dialog box opens, select one or more runs to open. If adding more
runs, select File|Open or hit F4 on the keyboard. Select a saved run from the list. To add a run to the list simply
select another run.
To print the table of averages select File|Print…, click the print speed button, or press Ctrl+P.
To save the table of averages in ASCII form select File|Save As Ascii.... A table saved as ASCII can be opened
again by Profile into Display Average by selecting File|Open.... Then choose the file type Ascii files(*.csv).
Choose a saved table from the list of ASCII files.
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To save the table for use in a word processor or as text select File|Save As Text.... Text files cannot be
reopened by Profile.

Brake runs:
Up to 10 more columns of information can be added to brake runs. Click on the "New Parameters" tab to add
more columns. Adjusted distance is the distance the vehicle would have traveled if it were traveling exactly the
adjusted speed. For instance in the example above the adjusted distance is for a speed of 30.0 MPH. The actual
speed must be within 5 MPH of the target speed or the adjusted distance will display 0.00 and will not be included
in the overall average.
If the test is close to 20 MPH click the 20 MPH button to calculate what the distance would have been if the
vehicle would have been going exactly 20 MPH. Similarly for 60 MPH. Any other speed within 5 MPH of the
actual speed can be used by typing it into the box then hitting Enter or clicking the Calculate button.
As many as 20 more columns of information can be added to acceleration runs. The same information as quick
stats is available for multiple runs using display average. Click the Default Parameters tab at the top of the
window or use View|Default Parameters. Then use the mouse to select the additional information to display. To
select more than one item in a list hold down the Shift or Ctrl key while selecting the item. Click Clear List to
select NONE for all items.

Up to 10 more Parameters can be created for cases where Profile doesn't include the information you need. Click
on the New Parameters tab at the top of the window or use View|New Parameters.
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Custom ranges of speed, time or distance can be displayed by adding New Parameters to the Display Average
window. Up to 10 new parameters can be added to acceleration or brake tables.
Click in a check box, then choose Distance, Time or Speed. Then choose a start and end value. Then choose
the calculation you want to show on the table. Then click on the Display Average tab to display the new
information.
On brake tests only G, Speed, Distance, Adjusted distance, Peak G and attached sensors are available.
Adjusted distance is the distance the vehicle would have traveled if it were traveling exactly the adjusted speed.
For instance in the example above the adjusted distance is for a speed of 30.0 MPH. The actual speed must be
within 5 MPH of the target speed or the adjusted distance will display 0.00 and will not be included in the overall
average.
If the test is close to 20 MPH click the 20 MPH button to calculate what the distance would have been if the
vehicle would have been going exactly 20 MPH. Similarly for 60 MPH. Any other speed within 5 MPH of the
actual speed can be used by typing it into the box then hitting Enter or clicking the Calculate button.

22. Graphing
Starting a Graph
Profile can graph one X axis and up to 8 Y axis. Up to 8 runs can be graphed simultaneously.
Click on Graph|Line Graph or press F2. The following dialog box appears. If the run file is empty or no run file is
open, select File|Open... or hit F4 to open a file to graph. Select the X axis and the Y axes you would like to
graph, any line color changes and Y axis scaling changes then click OK. Or click OK before selecting the axes
and the X axis will be Time and the first available 8 Y axes will be graphed. Click Clear to set all Y Axes to none.
Any available sensors will appear in order at the end of each drop down list.
Scaling:
Up to 8 different scales can be graphed at one time. When two different sensors are on different scales the graph
can look deceiving. Such is the case with Acceleration and Lateral Acceleration. If they are on different scales
Lateral Acceleration can look much larger than actual. Set the Scale numbers the same for each sensor you want
on the same scale. Profile automatically scales the axes for all sensors on the same scale. Other applications to
make the scaling the same would be tri-axis accelerometers; EGT sensors; or pressure sensors.
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Buttons:
Ok: Click to graph the data listed on the selected Axes.
Cancel: Abort graphing.
Clear: Clear all Y Axes to "None".
Help: Jump to the Help for graph.
Save: Save the current Axes, colors and scales to disk for later recall.
Restore: Restore the Axes, colors and scales from the last time Save was used.
Once the graph appears the individual Y-axes can be turned off by clicking on the corresponding checkbox. Click
it again to make the axis reappear.
Change the Y axis scaling by clicking on the line next to the axis name. To make the vertical reference line
appear, click on the icon
or select Graph/Data Cursor. Move the vertical reference line by clicking on the
data cursor and dragging it or by pressing the left and right arrow keys on your keyboard. Double click to move
the cursor to where the mouse is. The numbers on the right side of the graph reflect the position of the line as
you move it.
Zoom in:
Left click and drag the mouse from upper left to lower right.
Zoom out and re-center:
Click and drag from lower right to upper left.
Scroll graph:
Right click and drag with the mouse.
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To edit the graph, select the icon
style, width, titles, scales, etc.

or choose Graph/Chart Editor.... Here you can change the line color,

Adding a run to a graph
Profile can graph up to 8 runs on one graph. The runs will have different color lines which can be changed by
using the chart editor. Modifications to the vehicle setup can easily be viewed by comparing previous runs.
To add a run to a graph: If a graph is not already showing, open a run, then select Graph|Line Graph from the
menu, choose the X and Y axis. Click OK. After the graph is drawn select File|Open... or press F4. Select
another run and the same X and Y axes will be graphed. You can change the colors of the lines for the added run
by selecting a different color from the drop down box. It works best to only have 3 or less Y axes at a time since
the graph gets cluttered with more.

To create another graph while keeping the current graph, click on the Line Graph icon, open a run from disk, click
the OK button. Profile automatically maximizes the size of the window so use the Restore Down icon in the upper
left to see both graphs.
Changing graph setup
Profile's Graphs and Meters can be modified to suit your needs. The Line colors and styles can be changed; the
text including the labels and values can be changed; and the axis ranges can be changed.
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Use the Chart Editor to change the appearance of the graph. Select Graphs/Chart Editor....

To change the axes Scales, Title etc. choose the Bottom Axis or one of the displayed Y axes such as
acceleration, speed or distance. Left and Right Axis do not control any visible data.
Changing the Graph Range
A graph can be zoomed in or out by changing the Range. Use Graph|Range… to select a beginning and ending
time. It can be zoomed in on the X axis to 0.01 seconds. It defaults to the full length of the run. If more than one
graph is displayed the available range is the length of the longest one.
To zoom back out select Range again and click OK and Profile will graph the whole run.

Exporting a graph
A graph can be saved to disk in several different popular graphics formats. Saving a graph can be done two
different ways:
•
•

From File/Save as Metafile...
From the Chart Editor, Export, Picture.
• Choose a picture format, set options if necessary, then click Save... or Send....
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Using the Chart Editor, the data may also be exported to a variety of formats. See Exporting data on page 8.
Copying a graph to the clipboard
A displayed graph or Meters can be copied to the clipboard and used in other programs. This is useful for pasting
a graph into a presentation. Select Edit|Copy Graph to Clipboard or click Ctrl+C. Then select Edit|Paste in
another application to paste the graph.
Printing a graph
A displayed graph can be printed just as it appears on the screen. Select File|Print and Profile will open a
Preview window. Or click on the Print Preview button in the Chart Editor. Click the Print button to print the
graph.
The Printer Setup can be changed by using File|Printer Setup... or by clicking on the Setup... button in the
Preview screen.
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23. Real Time Playback with Meters
Profile can replay a run using analog looking meters. Add up to 6 meters and replay in real time or slow it down
or speed it up. Click Graph|Meters to open a dialog box to choose which meters to display. Select from the drop
down boxes or just click OK to choose the default meters. Click Clear to set Play Back Selections to none. Any
available sensors will appear in order at the end of each list.

The playback speed defaults to real time. Adjust the slider to speed it up or slow it down. The marks next to the
slider indicate the real time position. On slower computers it may not play back in real time. The more meters
that are showing the more the screen must be refreshed therefore slowing the display playback.
The meters will retain the low and high point of any meter with a marker.

37

24. Calculate Rolling Friction
Frictional Drag due to tires, drive train and brakes, also known as rolling friction, can be calculated using Profile.
Place the vehicle on an incline where the vehicle just starts to roll and rolls at a slow constant speed. If the
vehicle increases in speed, the incline is too great. Measure this angle using the VC3000 as described in the
VC3000 manual, method 2 of measuring Gradient and Super elevation. Type the number into Profile without
dividing the number by two. Profile will divide the number by two. The correct vehicle weight must be typed into
the current header for the Drag to be accurate. The calculated Drag will be put into the current runs header.
Profile uses Drag, FlatPlate Area, Wind, Altitude, and Temperature to correct for Horsepower and Torque losses
due to wind resistance.
This drag is only a portion of the frictional drag on a vehicle under acceleration because under acceleration the
friction between the gears and joints increase. The drag calculation also does not include transmission losses.
To get engine Horsepower a number must be typed in to the % HP Loss header variable.
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25. Calculate Flatplate Area
Flatplate area is the aerodynamic drag area of an object and can be calculated by Profile. In the case of a vehicle
it includes the frontal area with the curvature of the body parts plus the drag under the car. Flatplate area is NOT
the same as frontal area. Frontal area does not take into account the angle of the windshield, hood, curves of the
fenders, etc., nor does it take into account the area under the car affected by wind. Flatplate area includes all
sources of aerodynamic drag. If a car has a frontal area of 20 square feet, then the flatplate area would probably
be about 15 square feet.
Flatplate area is used by profile to compensate for Horsepower and Torque losses due to wind resistance. You
may notice that at higher speeds, say over 70 mph, that HP seems to decrease even though the RPM is climbing.
This is due to the fact that it takes some HP to overcome wind resistance. Eventually wind resistance is so great
that it takes all the HP available just to maintain a constant speed. The VC3000 would calculate 0 HP since there
is 0 G at a constant speed. Since the VC3000 calculates HP and Torque from G-force wind resistance losses are
not measured.
Once you find the flatplate area of a vehicle the number does not need to be changed unless you make
aerodynamic changes to the vehicle. After compensating with flatplate area you should have chassis HP and
Torque. To get engine HP and Torque you would need to type a value into the % HP Loss variable.
Vehicle Weight, Temperature, Wind speed, Drag and Altitude must be correct for Profile to accurately calculate
FlatPlate Area.
To calculate Flatplate area of a vehicle:
1.

Perform a programmed acceleration run to 60 seconds. Accelerate hard up to at least 60 MPH then put
the vehicle into neutral and let it coast. Upload the run to Profile and look at the Time(X) vs. G(Y) curve.
Notice the G forces go from positive to negative when the vehicle was slipped into neutral.
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2.

Take note where the vehicle was coasting and type the beginning time into the FlatPlate area calculation.
Type in an ending time 0.5 to 1.0 second longer than the beginning time. In the example above the time
would be from approximately 14.0 seconds to 15.0 seconds.

3.

Profile will calculate the FlatPlate Area and place the number into the header for the current active run.
Vehicle Weight, Temperature, Wind speed, Drag and Altitude must be correct for Profile to accurately
calculate FlatPlate Area. Profile uses Weight, Drag, FlatPlate area, Wind, Altitude, Station Pressure and
Temperature to correct for Horsepower and Torque losses due to wind resistance.

To see the difference flatplate area makes, save the run before and after the flatplate correction and graph the
Horsepower of the two runs. Notice how the uncorrected HP starts to decrease as speed increases but the
corrected one remains more constant or increases with increased speed.
When graphing horsepower and corrected horsepower use the same scale for each or the lines will overlap. If
you don't change the scales the curves will be the same but on different scales. Then click the radio button next
to the Horsepower or the HP SeaLevel buttons to change the scaling of the curve.
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26. Changing Program Options
Program options such as the units of measure, input port and baud rate can be changed by the user. Default
information for each imported run can also be set in the options.
To modify any of these variables select Tools|Options.

Units of Measure:
English:

Metric:

Time
Speed
Distance
G-Force
Horsepower
Torque
RPM
Gear Ratio

Seconds (Sec.)
Miles per Hour (MPH)
Feet (ft)
G (G)
HP
Foot Pounds (ft lbs)
Revolutions per minute (RPM)
Revolution per foot (Rev/ft)

Time
Speed
Distance
G-Force

Seconds (Sec.)
Kilometers per Hour (KPH)
Meters (m)
G (G)
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Horsepower
Torque
RPM
Gear Ratio

HP
Newton Meters (NM)
Revolutions per minute (RPM)
Revolution per meter (Rev/m)

Acceleration Units:
Acceleration can be measured in any velocity divided by time. Profile gives the 5 most common acceleration
units to choose from. G force units come from the earths gravitational pull at the surface as a reference point. 1
G is the force exerted on any object at the surface of the earth. The acceleration units will change in all forms of
Profile when different acceleration units are chosen. Choosing Metric has no effect on the acceleration units.
Changing acceleration units has no affect on calculations such as speed or distance.
COM port:
When the VC3000DAQ is plugged into the computers USB port and turned on for the first time, Windows will
install the drivers from the CD and create a new COM port. The data that the VC3000 sends to the computer is
compressed so only Profile can be used to import the data. The USB cable must be plugged in to both the
computer and the VC3000DAQ, and the VC3000DAQ must be on before opening Options in order for the USB
COM port to be visible.
Select Auto for the COM port to let Profile automatically search for the VC3000. When it finds the VC3000 it will
store the COM port number to disk and scan that port first next time so scanning time will be very short as long as
the COM port number doesn't change. If you choose a specific COM port Profile will only try communications on
that one port.
When using the RS232 port for communication, any COM port compatible with windows will work with Profile.
The port must not have a mouse, modem, joystick, or any other software running that controls the port in any way.
Baud Rate:
The baud rate is the speed that the VC3000 and the computer communicate. Select USB if the USB port is used.
If RS232 is used, set the baud rate to 19200. The VC3000 automatically selects USB baud rate if the USB cable
is plugged in.
Select Auto for the Baud Rate to let Profile scan for the correct baud rate. When it finds the correct baud rate
Profile will store it to disk and use that baud rate first when attempting to communicate with the VC3000 next time.
If you choose a specific Baud Rate Profile will only try to communicate at that baud rate.
Default Data Folder:
This is the default folder (directory) to open .RUN files from and save to when the program starts.
Lateral G calculations:
Check this box to calculate the summation of the vectors of G and lateral G. The G data will contain the new
vectored values and speed and distance calculations will be made from it. This check box has no effect on
acceleration runs or if no lateral G sensor was used. Using Yaw data to calculate speed, distance or average G is
only useful if the vehicles direction of travel is constant. If the vehicle shows an arcing curve there will be extra
lateral G due to turning, therefore speed, distance and average G will be too high when using the lateral G for
calculations. The calculation is:

G 2 + Lat. G 2 = Vectored G

This check box must be checked before using Display Average, Make Average or Quick Stats for Vectored G to
be accurate.

Header Defaults:
The Header Defaults page of options is only to set the default header information for imported runs. These
settings will be transferred to any new run. The data typed in here will be used for the header information on all
subsequent imports. This saves the time it would take to type in the redundant information for every run.
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Click on the Sensors tab to set the default sensor names, units, and range.

Sensor defaults:
The sensor defaults page of options is only to set the default names, units, range and smooth factor for imported
runs. These will be transferred to any new run. Changing these will not affect an open run. See Sensor Setup
on page 21 for a complete description of setting the range.

OBDII Defaults:
The OBDII Defaults page of options is only to set the default OBDII speed calibration ratio and smoothing for
imported runs. These settings will be transferred to any new run. The data typed in here will be used for the
OBDII information on all subsequent imports. This saves the time it would take to type in the redundant
information for every run.
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OBDII Speed calibration methods:
The speed reported by the vehicles OBDII computer can be calibrated for use in Profile. This does not change
the cars computer or your speedometer in any way. It only multiplies the speed reported by the vehicle by a ratio
and stores it in Profile. Profile only uses this ratio in the "OBDII Adjusted Speed" data. The "OBDII Vehicle
Speed" remains unchanged.
There are 3 methods to calibrate the OBDII speed. Before starting any of these methods, be sure to plug in the
VSI AFTER the car is running, and turn on the OBDII speed, with high scan rate, and no other sensors in the
VC3000.
Method 1 uses the speed from the VC3000.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Do a programmed speed test from 0 to 60 mph.
Acceleration hard all the way through the test.
Import the run to Profile.
Click the "To new run window" button on the import window.
Click the OBDII tab and click in the OBDII adjusted speed checkbox to turn the calculation on.
Be sure the ratio is set to 1.00.
Click the Data tab and scroll down the VC3000 speed column until you see the closest value to 50.00
mph.
Look at and remember the value in the OBDII adjusted speed column in the same row.
Click on the OBDII tab and type in the VC3000 speed (50.00 or so) in the Actual Speed or Distance box.
Now type in the value of the adjusted speed in the OBDII Speed or Distance box.
Profile will calculate the correct ratio and use it in the OBDII adjusted speed calculation and OBDII
distance calculations.

Sometimes the OBDII speed may have a flat spot where it took a long time to update the OBDII information. If
this happens at your target speed of 50 mph, then use the same process but use another speed such as 40 mph.
Method 2 uses the speed from a radar gun or GPS system. Use a radar that is mounted inside the vehicle.
1.
2.
3.
4.
5.
6.
7.

Do a timed acceleration test for 20 seconds.
Once 50 mph is indicated on the radar or GPS, try to hold that speed for 5 seconds or so.
When you feel you are the closest to exactly 50.0 mph, push a button on the VC3000 to stop recording.
Import the run to Profile.
Click the "To new run window" button on the import window.
Click the OBDII tab and click in the OBDII adjusted speed checkbox to turn the calculation on.
Be sure the ratio is set to 1.00.
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8.
9.
10.
11.

Click the Data tab and scroll down to the bottom of the data.
This should be where the radar or GPS indicated 50.0 mph.
Look at and remember the value in the OBDII adjusted speed column in the last row.
Click on the OBDII tab and type in the radar or GPS speed (50.00 or so) in the Actual Speed or Distance
box.
12. Now type in the value of the adjusted speed in the OBDII Speed or Distance box.
13. Profile will calculate the correct ratio and use it in the OBDII adjusted speed calculation and OBDII
distance calculations.
Using a radar unit may not be very accurate because most police radars truncate to the whole number. Therefore
the radar could indicate 50 when really you were going 50.9 mph. Some sports radar units will display speed to
the tenth of a MPH.
Lower priced, below $5000.00, GPS has a relatively slow update rate, 1Hz at best, therefore it may be difficult to
pinpoint exactly 50.0 mph.
Method 3 is the most accurate way to calibrate the OBDII adjusted speed. It uses milepost markers to measure
distance. Mile post markers are laid out by professional surveyors and are extremely accurate. This same
method could use a GPS device to measure distance but the distance will not be as accurate.
1. Find an at least 5 mile straight road with mile post markers.
2. Stop with a mile post marker lined up with the pillar post (support post between windshield and door) of
your car.
3. Turn on the VC3000 and use the continuous OBD mode. Save the test in memory when prompted.
4. Accelerate up to the speed limit and hold it there until you see the 5th mile post marker from where you
started.
5. Reduce your speed to about 30 mph and push a button on the VC3000 to stop recording when the 5th
mile post marker lines up with your pillar post.
6. Import the run to Profile.
7. Click the "To new run window" button on the import window.
8. Click the OBDII tab and click in the Calculate OBDII distance checkbox to turn the calculation on.
9. Be sure the ratio is set to 1.00.
10. Click the Data tab and scroll down to the bottom of the data.
11. This should be where the 5th mile marker was.
12. Look at and remember the value in the OBDII distance column in the last row.
13. Click on the OBDII tab and type in the actual distance (26400 feet for 5 miles) in the Actual Speed or
Distance box.
14. Now type in the value of the OBDII distance in the OBDII Speed or Distance box.
15. Profile will calculate the correct ratio and use it in the OBDII adjusted speed calculation and OBDII
distance calculations.
This method can use any distance as long as the test is not too long for the VC3000's memory, 14 minutes with
the OBDII speed on.

27. Troubleshooting
Also, see Profile Help for more details and solutions that may not listed here.

Importing Problems:
Problem A:
Profile will not take data in.
Solution A:
1. Windows XP used USB drivers from another device. Uninstall USB drivers and follow the instructions in
“USB Serial Port Installation” in Profile Help or on page 2.
2. The VC3000 is not turned on or is unplugged.
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3. Wrong COM Port selected. Go to Tools|Options… and select Auto or the correct COM port, usually the last
one in the list if using USB.
4. Profile’s baud rate is wrong. Go to Tools|Options… and select Auto or the correct baud (“USB” for USB or
“19200” for RS232)
5. The port number for the virtual serial port has changed. Go to Tools|Options… and select the correct port
for the USB serial port, usually the last one in the list and set the baud rate to “USB”.
6. The USB port drivers are not loaded yet. Wait about 5 seconds after plugging the VC3000 in and turning it on
before attempting to import.
7. Be sure only 1 cable is connected to the VC3000, either USB or RS232. Also, unplug the VSI from the
RS232 port.
8. PDA synchronization software such as "Hot Sync" is running and controlling the serial port. Close the PDA
software and try again.
9. Wrong cable or not connected properly.
10. Open Control Panel/Device Manager and check COM ports. “USB serial port (COMx) should be listed. If it is
not, check other devices and reinstall drivers if USB serial port has a question mark.
11. USB serial converter drivers not installed correctly. The latest drivers are available in the “downloads” section
of our web site. Follow the procedure “Uninstall of USB Drivers” on page 4. Then plug the VC3000 USB port
in again and follow the installation procedure on page 2.
12. Old version of Profile and new version of VC3000 firmware. Update Profile.

Problem B:
Error message: "COMx could not be opened" or “Output buffer too small for block”
Solution B:
1. The VC3000 is not turned on or is unplugged.
2. The USB port drivers are not loaded yet. Wait about 5 seconds after plugging the VC3000 in and turning it on
before attempting to import.
3. Wrong COM Port selected. Go to Tools|Options… and select Auto or the correct COM port, usually the last
one in the list if using USB.
4. Be sure only 1 cable is connected to the VC3000, either USB or RS232. Also, unplug the VSI from the
RS232 port.
5. PDA synchronization software such as "Hot Sync" is running and controlling the serial port. Close the PDA
software and try again.
6. Open Control Panel/Device Manager and check COM ports. “USB serial port (COMx)” should be listed. If it
is not, check other devices and reinstall drivers if USB serial port has a question mark.

Problem C:
Error message “Wrong response reading file count”
Solution C:
1. Wrong COM port selected. Go to Tools|Options… and select Auto or the correct COM port.
2. Wrong baud rate selected. Go to Tools|Options… and select Auto or the correct baud rate.
3. Be sure only 1 cable is connected to the VC3000, either USB or RS232.

Problem D:
Error message "ie_Hardware - hardware not present".
Solution D:
1. The Com Port is locked or in use by another device. Disable the other device or try another Com Port.
2. The Com Port doesn't exist in the computer. Select a different Com Port.
3. The driver software for the port is not present. Reinstall the port software.
4. The resources (address space and interrupt) in BIOS must match that of windows. To check BIOS settings
enter SETUP when the computer first boots up.
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Problem E:
Error message "ie_Open - device already open"
Solution E:
1. The COM port is locked or in use by another device. Disable the other device or try another COM port.
2. Profile or another program opened the port but didn't close it. Exit Profile and restart it. Or try closing any
DOS applications. Or you may have to restart your computer.

Problem F:
Error message “Access violation” when importing or “File not found” when opening Options.
Solution F:
The registry has corrupt information for the Profile program. Open the registry editor (Start, Run..., type regedit
and hit OK). Browse to HKEY_CURRENT_USER\Software\Vericom\Profile. Delete the whole key. Close the
registry editor. NOTE: backup registry first. Vericom is not responsible if you mess up the registry! Run the
Profile program again. It will create a new key with default values.

Program Problems:
Problem A:
Program not showing some data.
Solution A:
The user type may be set to the wrong setting for your application. See VC3000 Setup page 9.

Problem B:
Floating point error message after importing data.
Solution B:
A setting in the VC3000 was invalid. Use "Set Defaults" in the Setup mode. Runs in memory will have to be
deleted.
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